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Exercise 1 : Hello World
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Start Rhapsody in C++

* Double click RhapsodyInC++
» Select Run in Terminal

Computer
&l Home .
Ed Desktop <>
vy
@ Documents : L) A )
i Downloads Notepad redist.txt rhapsody.exe Rhapsody
il Music =
[m] Pickures A E =n
@ videos Rhapsody.exe RhapsodyCL.exe RhapsodyinC RhapsodyIinC++
= File System
& Trash
Gt sy @ Do you want to run "RhapsodyInC++", or display its contents?
) Browse Net... N "RhapsodylnC++" is an executable text File.
(m ]
L
"Rhapsodg;rlr.1[++"5elé | RuninTerminal | | Display | | Cancel | | Run

3 = — ==—




Creating a Project

= New from File menu

R IEM Rational Rhapsody Developer for C++ - [Welcome to Rhapsody]

%y File Edit “iew Code Layout Toolz Window Help

=2 =R A= A= @IKHQQI@IEIE I@IL
mgx@wm j
ml """" e [ I =S = R R | it Avial ém J/ B |é =

¥ Welcome to Rhapsody X ]

IBM Rational Rhappadu—

Project narme: oject
It Folder: I.-"hCImE.-"DDnerL-"HhapSDd}'?53a"PrDiECt Browze.. | k.
Project Type: | Drefault j »
Praject Settings: | Diefault j r
My Projec
Proces
Ok I LCancel | Help
NP | (™ B
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Select the working directory

Browse for Folder

Project name

I falder:

alal
L Y Please choose a folder,

Froject Type

Froject Settir

- Templates
-2 Wideos
=20 work
F-20 driver
-2 hello
23 module
-8 mq
{:l mutes

27 semaphore
-2 SocketCam

o]

=]

Cancel |

Documentation

Training ar

Browse... |

In folder: I.-"thE.-"CDHt[D'.-‘IWDrk.-‘IHhapSDd_','.-‘lH ello Browse... |

| Mew Project I

Fraoject narme: IHeIIn:n

Froject Tepe: I Drefault j

Froject Settings: I Drefault j ¥

ok I LCancel | Help |

Rhapzody B4 |

Directary fhomedcontraldwork./Rhapaody/Hella does nat exist
Do you want to create it?




Browser

* The browser shows you everything that is in the model.

* Note that Rational Rhapsody creates an Object Model
Diagram (OMD).

R IBM Rational Rhapsody Developer for C++ - Hello.rpy - [Object Model Diagram: Model1 *]

BED

ﬂ] File Edit View Code Layout Tools Window Help
DEH Ry &2 20 BGRE| X ||QKEOEE[0: v 2 # 0 %06 3
""""""" v DR BE BE = |- %
iy @Batang = :
o
- (Z] Object Model Diagrams 3 .
(] Packages O bJeCt
5 model
diagram
Browser
v
< >
uWeIcometo...]DE] Model1* I
IFOr Help, press F1 V GE MODE CAP | NUM SCRL Mon, 27, Apr 2008 3:53 PM

[e)]
[Jom]]
I;

.|||
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Drawing a class

* In this Object Model Diagram, click the Class icon 5

to draw a class named Display.

Expand the
browser to see
that the class
Display also
appears in the
browser.

ﬂ File Edit View Code Layout Tools Window Help

DSEsmEe 52 2

R IBM Rational Rhapsody Developer for C++ - Hello.rpy - [Object Model Diagram: Model1 *]

# G @ X

Show/Hide Drawing
Toolbar

QABOEB[w: v 2 WH 0% BuE

Ay T B ﬂf)efauhComponent

v | DefauitConfig

Entire Model View

= p3 Hello
(] Components
=-{Z] Object Model Diagrams
g5 Model1
=-(Z3 Packages
=-§ Default
=B Classes
8
- £ PredefinedTypes (REF)
£ PredefinedTypesCpp (REF)

v D ®E B e o

|| T Al g T Ee= =

% Select

=] _Ohis

| EH  dass ,
ool Composite Class
3 Package

-0 Port

Display

4 Generalization
L Assodation
Ly Directed Association
. Aggregation
€ Composition
L ik
Vil -
—'| "y Dependency

Xy Flow

< \ >

uWeIcometo“.I@ Model1 * ]

4 Realization

For Help, press F1

GE MODE CAP NUM SCRL| Mon, 27, Apr 2009 = 4:42 PM




Remove from View / Delete from model

» Two ways of deleting a class
» Remove the class from the view

(this is what the Delete key does).

» Delete the class from the model.

= |If you use the delete key or
select Remove from View,
then the class Display Is just
removed from this diagram,
but remains in the browser.

= If you select Delete from
Model, then you must confirm
with Yes in order to remove

the class from the entire model.

Display

Features...
Add New

Cut

Copy

Copy with Model
Delete from Model
Remove from View
Change to
Refactor

Navigate

Make an Object
Ports

Create Unit

Check

Generate
Edit Code
Roundtrip

Format...

Display Options...
Associate Image
Make Default
Expand to fit text

Rational Rhapsody Gateway
Create TestArchitecture

Ctrl+X
Ctrl+C

Del

Ctrl4E
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Adding a constructor

* The simplest way to add a
constructor is to right-click on
the class and choose
Add New > Constructor.

* You do not need any
constructor arguments;
click OK.

Constructors may also be
added through the
featuresOperations tab.
Click New and select
Constructor.

Display i
sid Features... I
| Add New 4 Statechart
Activity
Cut Ctrl+X
< Structure Diagram

Copy Sohi Attribute
Copy with Model Operation
JFEY T fioe
Remove from View Del [ Destrictes
Change to Port
Refactor FlowPort
Navigate » [

Arguments;
Hame Type " alue Add
v

&




Display options

* You would expect to see the
constructor shown on the class
on the Object Model Diagram.

* You can control what gets
displayed on this view of the

class by using Display Options.

* Right-click Display class and
select Display Options.

» Set the options to display All
attributes and All operations.

Display options of Display

Display options of Display

J

endkal | Attibutes | Qlerations
Show

CiMone @ al O Public () Explicit

10

Display

=}

% Display()

[ T— | SRR

Features...
Add New

Cut

Copy

Copy with Model
Delete from Model
Remaove from View
Change to
Refactor

Navigate

Make an Object
Ports

Create Unit

Check

Generate
Edit Code
Roundtrip

Format...

Display Options...

Associate Image
Make Default
Expand to fit text

Rational Rhapsody Gateway

Create TestArchitecture

Ctrl+X
Ctrl+C

Del

Ctrl+E
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Display constructor

= You should be able to see the constructor IS now
shown In both the browser and the OMD (object

model diagram).

R IBM Rational Rhapsody Developer for C++ - Hello.rpy - [Object Model Diagram: Model1 *]
g_ﬁj File Edit View Code Layout Tools Window Help

DM s$BE Y &% 2 AKE X

i LIS }DefauItComponent VIDefaultCorrfig

® & B3 B @[ v
v OB E B e

T T =) [N O i =2 R e | ¥

Entire Model View ~

= [ Hello

(] Components

Constructor

=-{Z] Object Model Diagrams

g5 Model1 Display
=-{Z3 Packages
=-f3 Default
=B Classes
% Display()

<

uWeIcometo”.J@ Model1 * ]

2

EE%OW/EIﬁWJI»éDHm@Wﬂ

HE

= |llo%1 B 2] @) %] = @ B 2

x|

Select

Object

Class

Composite Class
Package

Port
Generalization
Association
Directed Association
Agagregation
Composition
Link
Dependency
Flow

Realization
Interface

Actor

For Help, press F1

GE MODE CAP NUM SCRL Mon, 27, Apr 2009 | 11:31 PM
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Adding an implementation

= Select the Display constructor in the browser and
double-click to open the features window.

» Select the Implementation tab and enter the

following:

cout << “Hello World” << endl;

Constructor : Display in Display *

General Descrip; Implementation | Agquments | Felations

Drizplay(]

Tags | Propertiez

cout << "Hello World™ << endl:;

Locate K Apply

12

A

If you are not using Visual C++
6.0, then you should add the
std namespace, for example,

std: :cout << “Hello
World” << std::endl
Or, set the property

.
4

CPP_CG::Class::Implementati

onProlog to using
namespace std;.

a



#include <iostream>

= Since you have used cout, F
yOU m USt add an inC| Ude °l.. Atrbutes | Operations | Ports | Relations | Tags (| Propertes |
of the iostream header to |>=—"
the Display class. 5

ActiveMessageQueueSize

i

ActiveStackSize

= In the browser, select the i
Display class and double-| =22 4
click to bring up the

=!| Class

fe at u re S . AnimSerializeOperation

AnimUnserializeOperation

» Select the Properties tab e
» Ensure that the Common ||| (EEES—_—- ) |

IsReactivelnterface vl

View is selected e —

The Impincludes property specifies the names (including full paths) of header files to be

. . b of imol X
} E n te r < I O St re a m > I n to t h e "f-:lcelzc;?:'l:tfatthe%tf%e cIa?sz: ,n;%rj.gitt'g r;r object types, or packages. Separate multiple file

names using commas, without spaces.

“ImplIncludes” property. ryrys

Locate OK

F Implincludes is an abbreviation for Implementation Includes.

13
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Renaming a component

* I[n order to generate code, you must first create a
component.

» Expand the components in the browser and rename
the existing component called DefaultComponent to
Test. Also name the Directory to Test.

Entire Madel View < Component : DefaultComponent in Hello *
=1 Hella e : — : :
=53 Components v ycope || Varation Points | Description || Relations | Tags || Properties |
+ E DefaultComponent ke 5
+-[_7 Object Model Diagrams Name: A |
=-[27 Packages Stereotype: — j’i %I%
—I- 2 Defauit Directary: Test ;E]
--B classes ’ L
-8 Display Libraries: . [Z]
—|-[@ Operations Additional Sources [ | =
i, Display() L
Standard Headers:
+-F PredefinedTypes (REF) PR SRCT E]

+-F PredefinedTypesCpp (REF) Include Path:

Type
(O Library & ) Executable J O Other

Locate OK Apply

Executable

14
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Test component

* Now expand Configurations and rename the
DefaultConfig to Release.

Entire Model View - Configuration : Release in Test

= Hello
General | ndkerr T . . .
=2 Components Dgzcription | Imitiahzation | Settings || Checks | Relations | Tags | Properties
= E Test Feleaze
--[_1 Configurations .

+ ‘k DefaultConfig —
+-[_1 Object Model Diagrams
--[Z3 Packages
= & Default
--B Classes
- a Display
= ﬁ Operations
Y, Display()
+ & PredefinedTypes (REF)
+ & PredefinedTypesCpp (REF)

15




Initial instance

» Select the
Initialization tab,
expand the Default
package, and select
the Display class.

= The main will create an
Initial iInstance of the
Display class.

[ritial inztances

{(®) Explicit () Derived
= 4Ll

Generate Code For Actars

Initialization code

Setings | Checks | Relations

Tags | Properties

16
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Settings

= YOou need to select an
environment so that
Rational Rhapsody
knows how to create
an appropriate
Makefile.

» Select the Settings tab.

» Select the appropriate
environment, for
example: Linux.

You will learn about the
many other settings later.

Configuration : Releaze in Test
Felations I Taogz | Froperties i
Gereral I Description I Initialization Seftings | Checks
Directany; I#hnmea’cuntrula’wnrka’ﬁh | ¥ Lse Default
Libraries: | |
Additional Su:uuru:es:l |
Standard Headers: | |
|nzlude Path: I |
— Inzturnentation
Inztrumentation b ode: INnne j Edvanced .., |
—ehify
I- wieh Enabling Sdvanced ... |
Tirme Model: i+ Beal i~ Simulated
Statechart Implementation: ¢ Reusable s Flat
— Environment Settings
Ervviranmnent: ILinu:-: j Default |
Build Set: IDeI:uug j
Compiler Switches: |-, 1$0mMD efaultS pecificationDirectary ;I
$I0MROOT] -I$0OMROOT)ALangCpp ;I | =
Link Switches: FOMLinkCormmands et ;I
[ Include Requirements as Commetts in Code ;I

Locate | 1[4 I Appli | |

17
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Renaming the OMD

» Expand the Object Model Diagrams in the browser.
Right-click the Object Model Diagram Model1 to
Invoke the features dialog.

* Rename the diagram from Modell to Overview.

Entire Maodel View <

|- Hello
--[L7] Components
- §7 Test
-2 Configurations
+ "k Release
--[27 Object Model Diagrams

5 ode! 1

(1] Packages Open Object Model Dizgram

- B Defauii N

: =i Wi r
= E Cla Features in New Windov
B | add ew 3
Search...

+ EI Predefi Search inside,..

: El Predefi References...
Add to Favorites

0Object Model Diagram : Modell in Hello *

General | D
M arme:
Sterentype:

Default Fackage: | Default

Ik

Apply

18
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Generating code

* You are now ready to generate code.
» Save the model. &
» Select Generate/Make/Run. E#

» Click Yes to the question:

Rhapsody X

JiA

Directary ChworkiHelol TestiRelease does nok exist
Da you want o create ity

(e I
=0

L= be

411 Checks Terminated Successfully

Checker Done
0 Erroris), 0 TWarning(s)

Code generated to directory: Ahome/control/work/Fhapsody Hello/Test/Release

Generating f£ile Displav.h
Generating file Displav.cpp
Generating main file MainTest.h
Generating main file MainTest.cpp
Generating make file Test.makl

Code Generation Done

0 Erroris), 0 Warningis), 0 Message(s)
Euilding ------------ Test
Compiling Display.cpp
Linking Test

Euild Done

JIf K nnm Log .f{. Check Madel .Ih Euild .Ih Configuration Management h Animation !"

19




Handling errors

= |f there are errors during the compilation, double-click
the relevant line to find out where the error occurred.

EllEuilding ---————————- Test  ————————————

Compiling Display.cpp

Dizplay.cpp: In constructor A€~Display: :Display()ag™:
Dizplay.cpp:23:5: error: &€"outd®™ was not declared in this scope
make: *%* [Dizplay.o] Error 1

Constructor : Display in Dizplay

Build Done

f I I I 4 I PI HI'-. Log /4 Check Model # Buil

Generall Description  Implementation |.-'-‘-.rgument3 Helatinn&l Tagz I F'rnpertie&l L

|Display(] 3

out << "Hello World®™ << endl: -

Frezz the Chrl ke to prevent docking.

20
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Hello World

» You should see the following:

O™ E Test
Hello World
i

» Before continuing, make sure you stop the
executable by one of the following methods:

» Closing the console window.
» Using the Stop Make / Execution button. ®
» Ctrl+Break.

21
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Generated files

* The generated files are located in the following
directory:

F® Home work Rhapsody Hello Test Release

D|Sp|ay CIaSS \I:ame * | Size Type Date Modified

=.| Display.cpp 775 bytes C++source code Fri 29 Dec 2017 05:12:05 PM KST
=.| Display.h 804 bytes Cheader Fri 29 Dec 2017 05:12:05 PM KST
- h Display.o 27.8kB object code Fri 29 Dec 2017 05:12:05 PM KST
Malin \ error.txt 0 bytes plaintext document Fri 29 Dec 2017 05:12:05 PM KST
982 bytes Fri 29 Dec 2017 05:12:05 PM KS5T

= | MainTest.cpp C++source code

=.| MainTest.h 594 bytes Cheader Fri 29 Dec 2017 05:12:05 PM KST

Executable |=| MainTest.o 26.1 kB object code Fri 29 Dec 2017 05:12:05 PM KST
Release.cg_info 812 bytes plaintext document Fri29 Dec 2017 05:12:05 PM KST

@ Test 733.6 kB executable Fri 29 Dec 2017 05:12:06 PM KST

Makefile > =| Test.mak 3.7kB plaintext document Fri29 Dec 2017 05:12:05 PM KST

22




Editing the code

Display

* You can edit the generated files . :
. . . 1
from within Rational Rhapsody. owmd o e
. _ _ ]
» Select the Display class, right-click, i
. Refactor »
and select Edit Code. :
: : o g
= Both the implementation (.cpp ) and o
reate uni
specification (.h ) are shown In =
.
appea Windows.
FAHY package Default jf SAHE auto generated jﬁ
#include "Dizplav.h’™
FAHE class Display SAHE auto generated
class Display | #include <jiostream:
ey Constructors and destructors LS SAHH package Default
public : At class Displav
Display::Displav() {
AAHE operation Displavy) FAET operation Display()
Displayi(]: cout << "Hello World™ << endl:
FrH]
SO auto generated 3
~Dizplay();
I Display::~Displavi] {
w 1 w
iE: TN » IE: >
ﬂ Owerview * ]@ Display@p @ Dizplay.h ]) ﬂ Dvewiew( @ Dizplay.cpp Dizplay b

23




Modifying the code

* You can modify the generated code.

= [n the Display.cpp file, change the implementation to
print out Constructed instead of Hello World.

» Transfer the focus back to another window to
roundtrip the modifications back into the model.

* Note that the model has been updated automatically.

SAESE auto generated
#include <iostreatn:-

FAEE package Default

SAHY class Display
Display: :Displavyi(] i

E o S — N e s g e T
Ccuut << "Constructed”™ << endl; )
Pl

}

Display::~Displav () I

NE3
g Drizplay. h

85 Owverview( [Z] Display.cpp

* |[n general, the roundtripping works very well, but
beware not everything can be roundtripped.

24
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Displaying the Main and Make

= The Main and Makefile can be displayed by simply
double-clicking the hyperlinks:

Entire Model View ~

= pd Hello
=[] Components
E]&ﬂTeﬂ
=-{Z3 Configurations
= %\, Release
=)&) Hyperlinks
8
I3 Edit Makefile
=[] Object Model Diagrams
g5 Overview
=L Packages
EfE:]DehuR
#- £ PredefinedTypes (REF)
@£ PredefinedTypesCpp (REF)

<

‘./'****i’f*f***i'*f***}f!’f*}*i'ff***}i'*f***f}*****i***_]
4 ~

Rhapsody s FH —
Login user
Component Test
Configuration Release
Model Element Release
/! Generated Date Tue, 28, Apr 2009
File Path Test\Release\MzinTest.cpp
Bt Bt o o

#include "MainTest.h"

//## auto generated

#include WDisplay.h"

int main(int argc, char* argv(])
int status = 0;
if (OXF::initialize())

Display ~ p_Display;

p_Display = new Display;

//#[ configuration Test::Release
S/E]

OXF::start ()

delete p Display;

status = 0;

else

i bs

€

@MainTest.cpp]@ MainTest.h ]

25
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Project files

AutoSave

I’ Home

work Rhapsody Hello Test Rel

Generated code

>

=

Project workspace

Hello_rpy
Test
Hello.ehl
Hello.rpw
Hello.rpy

Hello.save

L

Size Type

|l Hello_auto_rpy 0Oitems folder

4items Folder

26

1item Folder

64 bytes plain text document

1.3 kB plain text document
.5kB plain text document

tes plaintext document

Date Modified

Fri 29 Dec 2017 05:17:50 PM KST
Fri 29 Dec 2017 05:04:05 PM KST
Fri 29 Dec 2017 05:12:05 PM KST
Fri 29 Dec 2017 05:07:50 PM KST
Fri 29 Dec 2017 05:07:50 PM KST
Fri 29 Dec 2017 05:04:05 PM KST
Fri 29 Dec 2017 05:07:50 PM KST

The model




Extended exercise

= YOU can customize Rational

Rhapsody to get quick access to the
location of the current project.

= Select Tools > Customize.

Menu content:

IR O S 2
-

Apply ATG...
Rational Rhapsody Gateway
MNavigate to Original Tool

Edit TestCase SDInstances
Update TestCase

Build TestCase

Execute TestCase

Create SD TestCase

Rational Rhapsody Gateway Synchronize

Helper parameters

|

|

Type

Cancel

A

27

IGLE Window  Help

Diagrams »
Browser

Main Diagram

Check Model »
ReporterPLUS 4

Report on model

Sosonze——————

Reverse Engineering
Typelibrary Importer

Import from Rose »
Import from Eclipse
Import from System Architect

VBA »

Sequence Diagram Compare
Automatic Test Generator
Test Conductor




Customize

Click to enter a new entry
Explore to the Tools menu.

Set the Command to
explorer.

Set Arguments to .
Click OK.
Select Tools > Explore.

Gl Window  Help

<

Wiew

|Menu content:

(O 1+

Create Testarchitecture
Clean TestComponent
Update Testarchitecture
Execute TestContext Sync
Execute TestPackage Sync
Load TestResults
Set RTC SilentMode
Reset RTC SilentMode

~

Command:

Arguments:

Initial directory:

Applicable To: |

Project Type: |

Helper Trigger: !

Type

(®) External program ) ¥BA macro

[]'wait for completion

Show in Tools menu

ok |

Apply ][ Cancel ]

. Address |[E| CriworkiHelo

V|G|:|

Diagrams 4
Browser
. File
Main Diagram
Check Model
ReporterPLUS > Marne
Report on model
| / [EIHE"D_[‘D‘:.-‘
Cegoe Syres
Customize... @ atg.log
Hello, row
£

28

Size | Type

File Folder

File Folder

File Folder
OFKE Text Document
1KE RPW File

Date Modified
300062008 16:37
30/06,2008 16:07
30/06,/2008 16:23
30/06,2008 16:07
3000602005 16:07 ¥




Exercise 2: Count down

UNIFIED o
MODELING
LANGUAGE

HeE Test

Conzructed
Started
Count
Count
Count
Count
Count
Count
Count
Count
Count
Count
Count
lone

10
9

29
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[ -1

Rhapsody

Copying a project
Computer + [® Home work Rhapsody

»Select File > Save As.
=Press & to select the work folder.| Zo, e - e

» |l CountDown Sitems Folder
i} Documents

"Press ci to create a new folder. | woones e v e

=Rename New Folder to —
CountDown. Save in [ 23 CourtDonr EREEES

=Select the new folder CountDown.

»Save the project as |
CountDown.rpy. Y T 5 ==

*The new CountDown project is
opened In Rational Rhapsody Wlth
the previous workspace p~

Each time there is an auto-save, Rational
Rhapsody only saves just what has changed
since the last auto-save.

30
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Loading a project

* Choose one of the following ways to open a project:

» Start Rational Rhapsody and select File > Open.
» Or double-click on the (3countbown.rpy file.

» Or start Rational Rhapsody and drag the {Jcountbown.rpy file
Into Rational Rhapsody.

» Or use Open Project in the Welcome screen.

open 7% \

Look in: l (=3 CountDown v ‘ C NG e |

L_j CountDown_ATG @ With All Suburits

() CountDown_rpy (O Without Subunits

(O Restore Last Session D p en P rﬂ] ect
Open a previously created Rhapsody
Froject.

File name: [99_‘{'}!?_9"_"“ oy | [ Open I

Fles of type: | Rhapsody Project(s) Cpy.* ) v| [ Cancel | Proceed o

The Rhapsody.ini file determines which Rational Rhapsody (C/ C++/J/Ada)
will be opened on double-clicking the .rpy file.

31
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Adding an attribute

* To add an attribute, double-click on the Display class
to bring up the features and select the Attributes tab.

» Click New to add an attribute count of type int.

= Set the Initial value to O.

Clazz : Dizplay in Default *

Display

= count-int=0

i Display()

32
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Generated code for an attribute

» Click Save E then edit the code for _ T T e |
the Display class so you can examine | = o
the code. s

E Display.h
public :

Initial Value

S/ #% operation Displayv()

Di=plav():

E Display.cpp

o gensrated Fi## class Display
Display:::Display() : count(0)

Fi#] operation Displav()

cout << "Constructed" << endl:;

FAET

o

L
tCount () const;

= = = -1
L gl fElaErE‘:EM

S/## auto
vold secCount(int p count):

}

protected

Displavy:::~Displav()
int count; ¥

int Display::getlount () const {

void Display::secCount (int p count)
count = p count;

Protected attribute

H

Accessor

return count; ‘/////

Remove from View Del
Change to »
Refactor >

Navigate »

Make an Object
Ports »

Create Unit

Check
Generate

Roundtrip

BX]

Mutator

il

33




What are accessors and mutators?

= By default, all attribute data members in Rational
Rhapsody are protected.

= |f other classes need access to these attributes, then
they must use an Accessor, for example, getCount()
or Mutator, for example, setCount().

» This allows the designer of a class, the freedom to
change the type of an attribute without having to alert
all users of the class. The designer would just need to
modify the accessor and mutator.

= [n most cases, attributes do not need accessors or
mutators; you will see later how to stop them being
generated.

=)



Attribute visibility

* Changing the Visibility in the Attribute features dialog
changes the mutator and accessor visibility (not the

data member visibility).

Attribute : count in Display

Attribute : count in Display *

Attribute : count in Display *

General |Description Relations | Tags | Properties = General |Descliptinn Relations | Tags | Properties General |Descriptinn Relations | Tags | Properties
N ame: |count | Mame: |c:u:|unt | M ame: |u:u:uunt |
Steretype: | v| [ﬂ|%| Sherentype: | v| %|%| Steretype: | v| %|%|
Attribute type attrbute type Attrbute type
Use existing type Ilze existing type Use existing type
Type: lint o L Type: it v| Type: lint | =
YWizibility Wigibility Yizibility
@ Public JO Protected (O Private ) Public | & Protected 0 Private O Public O Pratected
v
Locate ik Locate [als Apply Locate o] apply
= count ™ count & count
public : protected private
//## auto generated ## aute generated //## auto gensrated
int getCount () const; int getCount() const;: int getCount() const;
//## auto generated ## auto generated //## auto geners
void setCount (int p count); void setCount (int p count): —

Attributes

protected :

int count:

4
e

Attributes

protected :

int count;

35
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Attributes

protected :

int count;

s
4,

ted
void secCount(int p ¢

ount) ;




Adding an operation

» Using the features for the Display class, select the
Operations tab > Primitive Operation.

* Add a new primitive operation called print.

yisibility

TriggeredOperation
Construckor
Destruckor

void Meszzage_1]]

Locake Ok

GEenera || Description | Attibutds | Operations |F'rts Relations | Tags | Properties
“I-_-F"-

Genera | || Description

Attributes

Operations | Ports | Felations

Tags | Propertiez

H

R X

Yisibility
Public

void Meszsage_1()

Locake OK

Apply
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Arguments

» Double-click Print to open the features for the print

operation.

» Select the Arguments tab.
= Add an argument n of type int.

Primitive Operation : print in Display

General | Descrption Implementatiﬂn -'*'_-TEIUI'I'IENS iH;ﬂtiDHS Tags || Properties

e —_
|\-'n:uin:| print[int r) |
7 1T +
ame - Twpe Yalue Direction
ﬁ'] - -
\_ <IEw =
Locate (8] 4
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Adding implementation

» Select the Implementation tab for the print operation
and add:

cout << “Count = “" << n << endl;

General | Descript 1Implementatinn gumentz | Relations | Tags | Properties

woid printfint

cout << "Count = " << n << endl:

[[ 3

[ &

< |

| ™

Locate Ok,

38




Another print operation

" |[n a similar way, add another operation called print,
this time with an argument s of type char* and with

Implementation:

cout << s << endl;

Primitive Operation : prinkt in Display *

General | Description Implementatnl Argurnents |Fi lations | Tagz | Properties
. _—

Primitive Operation : prinkt in Display *

|v|:|i|:| prift(]

i “r <+
Marme Tvpe Yalue Direction
E:.] - -
<Mew =

Locate K Apply

7]
o

|w:|i|:| prift{char” =] |
s =

cout << = << endl:; ) A

¥

< ?
Locate Ik Apply

A

Set the argument type before setting the name.
This avoids a conflict where the two print
operations have identical signatures.
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Operation isDone()

» Add another operation called isDone that returns a
bool and has the following implementation:

return (0==count) ;

F® _
Primitive Dperation : isDone in Display * [=][=

Class : Display in Default *

General | Dezcription | Attrib tes| Operations | Hortz | Relations | Tags || Properties

......

General | Descrig 'u:un| Implermentation | gumentz | Relations | Tagz || Properties
e —

| bool izDonel] |

Mame Wisibility Return Type -
b Display Public Lreturn (D==count) ; ) ~
E print Public wiid

Public

( E isCone Pubilic

5.4

[
|

woid iz0one|] | ‘

Locate (04 Apply

By typing O==count instead of
count==0, enables the compiler to
detect the common error of where =
Is typed instead of ==.

40
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Active Code View

N Code  Layout  Tools  Window  H

= Select View > Active Code View.

= The active code view Is context
sensitive and is automatically updated s

Label Mode

FoomfPan 4

as the model is changed. The window - #e=res
also changes dynamically to show the =
generated code for the highlighted v reses
model element. T
) i= Properties
ide £1
[ = Cubput dindo Alk+3
| H
y, e e :
Note that although leaving the active py u
code view always open is useful, it } - -
does slow down model manipulation O o )
since the code will get regenerated S T m T m e enal
anytime any model element gets . 8
mOdIerd. \ Display.h l;\.|Di5|:|la'_.r.l:|3|:| ,f
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Using the print operation

= |n the Active Code View,  Active Cods View
change the code for the [ e D o | 1
constructor to use the print ez
operation. o
» Make sure you have selected jropiey e .
the Implementation. : e o ) 2

» Change the focus to another window such as the
browser and check that this modification has been
automatically round-tripped.

= Save the changes. ®
= Generate / Make / Run. i
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Adding a statechart

* You would like to get the Display class to count down
from 10 to O In Intervals of 200ms.

* To do this, you need to give some behavior to the

class. You can do this by adding a statechart.

» Right-Click the Display class and select Add New >

D —0 Q
Display
Features... I
= count:int=0 Add New »| Statechart
Cut Ctrl+X | ety
u ;
i Structure Diagram
) &“_-. DISplaY() . Copy Ctrl+C Attribute g
& print(n:int):void Copy with Model i
@ print(s:char*):void Delete from Model Cg:srjru?::or
& isDone():bool Remove from View Del
L I ol Destructor
= O Ref; gic r i
S |  FlowPort

MNavigate » [
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Draw a simple statechart

Upy@lt4@e@ @@/ / U

Transition

Default Transition

And Line

Condition Connector
History Connector
Termination Connector

Junction Connector
Diagram Connector
EnterExit Point
Join Sync Bar

Fork Sync Bar
Transition Label
Termination State
Dependency

Send Action

Action
Default | fcount=10; /
transition print("Started"). Trigger
| Active |
State /.( tm(200)
printk”””f/ Guard
/ [isDone())/

Transition

44
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Transitions

* Once a transition has been drawn, there are two ways
In which to enter information:
» In text format - example: [isDone()]/print("Done”);

» By the features of the transition (activated by double-
clicking or right-clicking on the transition).

Transition : 2 in StatechartOfDisplay

tm(200)/

3 G I ioti i
print(count): ENers |Desu:r|pt||:|n Tagz | Properties

Marmn | |
Ctrl+Enter closes ST v| G|t
[isDone()) the entry field. [Eies
print{("Done");
' Trigger :
Features...
é Delete from Model Guard: |i$D are ]

Action

Navigate

print("Done’™) ;

An empty line forces the action =
to appear on a new line. Locate

[

45

&




Timer mechanism

= A timer Is provided that can be used within the

statecharts.

* tm(200) acts as an event that will be taken 200ms

after the state has been entered.

= \When entering into the state, the timer will be started.
» \When exiting from the state, the timer will be stopped.

tm(200)/
print(count);

A

The timer uses the
OS Tick and only
generates timeouts
that are a multiple
of ticks.

=)



Timeouts

* |[f you have a system tick of say 20ms and you ask
for a timeout of 65ms, then the resulting timeout will
actually be between 80ms and 100ms, depending
on when the timeout is started relative to the

system tick. Systom tick

—>

20ms

o
»
a

“ 80ms < Timeout < 100ms

time

Start timeout End timeout

If precise timeouts are required, then it is recommended you
use a hardware timer in combination with triggered operations.
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Counting down

= Save H=

= Generate / Make / Run #

Constructor

Constructed
Started

Count
Count
Count
Count
Count
Count
Count

Default Transition

BFENWARUTIN-JO

10

Do NOT forget to close this window, before

& doing another Generate / Make / Run.

48

.|l|
®



Statechart symbol

* Now that the Display class is Reactive
» A reactive class Is one that reacts to receiving events or

timeouts.

» Identified by symbol in the browser &/ and the OMD. &
» Also note that the Statechart appears in the browser.

j - count
=- (@ Operations

% Display()
& isDone(
& print(char*s)

o] Dated
&, default of Active
=) States
#-{T) Active
@ condition_2
[+ @ terminationconnector_5

49
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= count-int=0

# Display()

& print{n:int)-vaid
& print(s-char*):void
& isDone()-boal
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Generated code: display.h

» Use the Active Code View to examine the generated

code for the Display class.

: Active Code View

B=1[E3

Framework class ~—_

.-'.u..u._ J=rn
/ # auteo =snerated

#1nclude {Dxfﬂnmreactlfe h-

.-'.u..u._ J=rn
/ # auteo =snerated

#1nclude {Dxfﬂstate h>

Framework includes ——1 |

¥ DaChade Deranlt

.u..u._,_.

S 7EE class Display
class Dlsplay : pubkliec CHEeactive {
Thread on s/7/ con 5"ru:':;—m—dq13_ pmetors

which to wait T plIteT———

S /## operation Disglav()
Diszplay (ICxfActivef thelctiveContext = 0

).

L0y isptay.b fy Sagieyces f

Note that the Display class inherits from OMReactive, which is
one of the framework base classes. This is a class that simply
waits for timeouts or events. When it receives a timeout or an

event, it calls the rootState _processEvent() operation.
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Generated code: display.cpp

» Display::Display(IOxfActive* theActiveContext)
» The constructor needs to know on which thread to wait.
» Display::initStatechart()
» Called by the constructor to initialize the attributes used to
manage the Statechart.
» Display::startBehavior()

» Kicks off the behavior of the Statechart, invokes the
rootState entDef() via OXF calling
OMReactive::startBehavior().

Typically invoked from outside after construction completed.

» Display::rootState entDef()

» Called by OMReactive::startBehavior() to take the initial
default transition.

» Display::rootState processEvent()

» Called though OXF operation OMReactive::processEvent()
whenever the object receives an event or timeout.
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Statechart implementation

= Change the statechart implementation e

» Select the features for the configuration
Release.

» Select the Settings tab and set Statechart
Implementation from Flat to Reusable. N

» Save / Generate / Examine code.

* The Rational Rhapsody framework aIIo|

General | Description InitializaticG Setlings ;aaks Relations | Tage | Properties

N —

Directary: |

| . [¥]Use Default

Libraries: |

Additional Sources: |

Standard Headers: |

Inelude Path: |

Instrumentation

Inzstrumentation kode:

Mone

ehify

i abling

Time Model:

oooooo

v| [ Default ]

ways of implementing statecharts:

» Reusable is based on the state design pattern where each state is an

object.

= Results in faster execution and if a lot of statecharts are inherited,

can result in smaller code.

» Flat uses a switch statement.

= Results in less code that is easier to read, but is slower.
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Extended exercise

» Experiment with the line shape of transitions.

/count=10;
print("Started”);
Active |
L
[else)/
--count;

tm(200)/
print(count);

Features...

Delete from Model
Navigate >

Select Trigger »

Line Shape >

User Points >

Format...
Display Options...
Make Default

Rational Rhapsody Gateway

Straight

Spline

53
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Design level debugging

= Up to now, you have generated code and executed It,
hoping that it works. However, as the model gets
more and more complicated you need to validate the
model.

* From now on, you are going to validate the model by
doing design level debugging, this is known as
Animation.

=)



Animation

» Create a configuration by
copying the Release
configuration:

» Press Ctrl and drag the

Release configuration onto
the Configurations folder.

» Rename the new
configuration Debug.

= Set the Instrumentation
Mode to Animation.

Configuration : Debug in Teskt

~
General | Description Initializati|€| Seftings Eiecks Relations | Tags | Properties F
e

Directany: | | se Default

Libraries: |

Additional Sources: |

Standard Headers: |
Include Path: |

fTatal
(" Instmentaiion Mode: | ITETT M | | Advanced..
i

w/ehify
[]'web Enablfa B
ire Model (%) Real () Sirnulated

Statechart Implementation: (%) Reusable () Flat

Erwironment Settings

E rnvironment;

|Micmsnft V| [ Drefault ]

Locate Ok

-5 Test
--23 Cu:unﬁguraticuns/
+ % Release

55

-8 Test

—-{_] Configurations
+ % Release

+ *\ Release_copy

-8 Test

--{_] Configurations

PSRN ...

+ "k Release
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Multiple configurations

* Now that you have more than one configuration, you
must select which one you want to use.

* There are two methods: -

» Right-click the configuration e .
and select SN <o p——

] . . %, Relea
Set aS ACtIVe COnflgUratlon E&L:jObjectModelDiagl Add New
i=-[_] Packages
= £ Default Cut
=B Classes Copy

= % Display
= At Delete from Model

B Changeto
=@ OF Refactor

» Select the configuration
using the pull-down box.
E Navigate

= Set as Active Configuration

it ! Edit Makefile
= E__E‘ Edit Configuration Main File

| ’ -Test
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Animating

» Make sure the active configuration is Debug before
doing Save HE then Generate / Make / Run.

» Run will cause the Animation toolbar to be displayed.

R IBM Rational Rhapsody Developer for C++ - CountDoxi.rpy - [Object Model Diagram: Overview]
@ File Edit View Code Layout Tools Window Half
| |laaE@E @i v 2 |0 #a %8 s
0 [Tes (Closs YO ®E BA |
L || T @Batang R e e s
f‘ 2
5.,EJJ%EZElj.f?’:;Ti:f.:':ffﬁi';’fi_;‘~ =
Entire Model View Dispiay o Select
= [;j CountDown : o
Wn@nsﬁ’-& '\M MM' *‘\W” ’«M~W~’~Mg 1
s l 1 b Predeﬁn’edTypes(_pgS (REF) .“,.“ R e S e gt ./'~.,-.-4_ .‘“/__ Yo _/ S S -)_/.. .”-'_',u. '._:/"_'u. _— /,,,,_/ e ek -' S . Faed o st nem
3 A Realization
¢ 3 [ 9 Interface .
— — ﬁ Actor
o] besoatet = ¢
,Q!j ke il 5 Common _ v
x| x| x|
K| k1 k1
o —" A~
(VCaII Stack_f J | ' Event Queue ] | [I]@\Log )\ Check Model }'\Bmld )\ Configuration Managemen )\Ammat:on
ForMefprpressie’ GEMODE CAP NUM SCRL Wed, 29, Amzosg—mw. ,
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Animation Toolbar

= Automatically appears when an executable model is run and
Instrumentation is set to Animation.

» To display or hide during animation session, select View > Toolbars >
Animation.

» For detailed button information, select Help > Help Topics
and search on animation toolbar.

» For example, grayed out (disabled) Thread button indicates single-
threaded application. 1

MEP KI5 @\-F
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Starting the animation

» Click the Go Step M button.

» Note that the Display() constructor appears in the Call
Stack.

» Continue to Go Step M until the Executable is Idle
message appears in the Animation window.

ﬁ Dizplay(]
2|V cunder construction: - prifit[s = Canstructed)
A Displayl)
il Display(]
|
Call § 4
x| Digplay[0]-=Start Behawiar
Al
Call Stae = Display[0]-> print[z = Started]
K1 Drizplay[0]-=Start Behavior
_Call Stac il Display[0]-: Start Behavior
Call Sta
- ﬂ Executeble is Idle ﬁ
Call Stack
Call Stack
Call Stackf
[ <] »]M]\ Buid }_Check Mode Call Stack /
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Class Instance

* Browser contains an instance of the Display class.
» Right-click the instance and select Features.
» Note that the attribute count has been initialized to 10.

= % Display
= = Attributes
- count
= & Instances

® @ Operations
B Statechart

Add New

‘ @ -
»

%]
Instance Name: loisp|ay[0] J
Attriutes, —
Name Value 3 Type

count 10 int
k.

3 | >
Relations:

|+

Locate

OK

&



Statechart Instance

* Right-click the instance and select Open Instance
Statechart.

» Highlighted state indicates the I_s.:_nunfm;
current state of the model. — =¥
= |f you do not see a highlighted tm(200)
state, you may be looking at the f %;”"":“”"”:
statechart of the class (design) T

rather than the statechart of the prini("Done");
Instance (runtime). ©

» Default transition has also been
tri ggere d. &% "C:\Program Files\IBM\Rational\Rhapsody\... B

= Started will have been
printed to the display.
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Go Ildle / Go

= Click Go Idle p» to advance to next timeout.
» The executed transition chain in statechart IS hlghllghted

s

= Value for countis . -roresme e
printed to display. : I

- . 4 /count=10;
= Con d Ition IS g print("Started"):
2 Active
checked for —
- d ? print(count);
IS Adone. T I /{5
-
= Not done so value @ e
. & —COHnL. [isDone())/ -
Of COU nt IS ’\ i Join Sync Bar
b T i Fork Sync Bar
d e C re m e n te d ﬁi Instance Name: | Display(0 2% Transition Label
] L;/ Attributes: - =t @ Termination State
" : 4 | +v || *»  Dependency
* Click Go ¥ and e air
gspl . . |
watch the animation 5 « :
i BRLlonsg b aphei®. . ogn. dienadth o afeaind giton g @ne b o o 8 oo,

until the instance Is
destroyed.

» Exit the animation. ™
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Destructor

= Add a Destructor [z¢ to the Display class.

* Add implementation print

Destructor : ~Display in Display *

General | Descriftion | Implementation | BElations | Tags || Properties
| voig <Display) —_ |
r 4 .
kprint ("Destroyed™) : ) =
v
3 | >
Locate (04 Apply

Display i | ,
Features... l
H count:int=0 Add New 4 Structure Diagram
| Attribute
o % Display() (C:Ut E:::Z Operation
& print(n:int):void c°py i Constructor...
B print(s:char):vo]  _oPY Wt Moce
B isDonef)bool Delete from Model Port
L (¥ Remove from View Del
Chiavce o FlowPort
O O
Refactor 4 [

=

& b Default
=B Classes
= @, Display
- Attributes
=@ Operations
¥, Display(
i isDoneQ
& print(char=s)
& print(int n)
@ Statechart

(“Destroyed”) ;

A

Make sure you enter the code
into the Implementation and not
the Description field.

» Save | then Generate / Make / Run !
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Sequence diagrams

* From the browser, create a new seguence diagram
called execution.

» This sequence diagram will be used to capture what
happens in execution.

» Operation Mode will be discussed later but for this example,
It does not matter if Analysis or Design Is selected.

BYS] Courntoonn & ‘
+ D Compon Features... 1 :
R R s ety  AddNew [ Package New Diagram X
= Package - Component —_—
=) EI Defz Search... ‘ : Selected Owner: sequencediagram_O
Search inside... Settings "
=8/ i fil e ti
EE Locate on Diagram Profile I M armne: |E:-:Ec:u (laly} ]. |
References... i . B bi N 1
Add to Favorites ‘ Object Model Diagram Uperation Mode
Biowses Froat here Relations » Sequence Diagram . .
3 | Annotations »| Use Case Diagram © Analysis O Design
Edit Unit... |  Component Diagram
T : Deployment Diagram [ oK. ] [ Hel ]
Configuration Management 4 : : 1=l Oelp
= : Collaboration Diagram
ormat... Structure Diagram
- B2 Prec Rational Rhapsody Gateway Panel Diagram

#-£ Prec Rational Rhapsody Gateway Synchronize
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Adding instances

* Add a System Border to the sequence diagram.

Entire Model View 22| v 7 L]

= 3 CountDown
[+ C:I Components
#-{_] Object Model Diagrams
=-{_] Packages
= £ Default

= -

# [ Predafioadlpac i
#f3 PredefinedTypesCpp (REF)
=L Sequence Diagram
f| execution

ENV

NANNNNNNNNNNNNY

Aot aian “L’.‘M..

‘o9t i %

v DataFlow

'* Asiy”srtem éoraer

Create Arrow
Destroy Arrow

Timeout

Time Interval

Reply Message

Cancelled Timeout

* Drag the Display class from the browser onto the sequence

diagram.
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Drawing a sequence diagram

= Normally, you would describe an actual scenario
similar to this one here, however in this case, you are
more interested In capturing what actually happens.

EMNW Display

7 |

“

o S

ﬁ ? | print("Contructed”)

o

g A g mt("Started"}
For the purpose of Z \\\‘\') —
this training, you only Z R A\ .

% ' \\\ 200
need the system 7 \\B o0

o \
border and the Z )
Display instance line. ‘V\ jl onel)
There is no need to N o
add any operations. ;"é Brint(n) 10)

7 ]

7

;ﬁ tm(200)

,,,,,: i

7
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Animated sequence diagrams

= Start the animation and click

Go. k& |
e "C:\Program Files\IBM\Rational\Rhapsody\.... JR[=] B3

<] =

* |f a sequence diagram is open,

then Rational Rhapsody
Ccreates a new animated
sequence diagram based on
the execution.

» Note that the animated sequence

diagram captures operations,
timeouts, and states.
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ENY Display

_E“ execution * _EU Animated exl

N
g
|
|Z

print(s = Constructed)

print(s = Started)

U

‘f Active
hY

/
tm(200) at ROOT Active

i

isDone()

T]

=

print(n = 10)

=== Y
/ Active \
o it — bt apifetien o g

,{\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\

Y
'

\
il

¢
\
'\

i

Ot

Ml

tm(200) at ROOT Active

isDone()

| print(s = Done)

]

print(s = Destroyed)
b 2

<

o 7L
v R ——n
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Extended exercise |

» Rational Rhapsody can
display the return value on
animated sequence
diagrams. To do so, you
must use a macro
OM_RETURN.

0 =isDonef)

[

=

printin =

]

tm|[2EIEI]| at ROOT. Active

T s

] ] 1=zDone()

* In the iImplementation of the S
operation isDone(), replace rl_;.
return with OM_RETURN. D

General | Description | Implementation | Arquments | Relations | Tags | Properties ;EESEIFD_ - _.'1 print(s = Destroyed)
boal isD one(] f
C_OH_RETT.TRN (O0==count) ,__?) ~
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Extended exercise |

* Try adding an extra state pausing. Then you will
see the instance changing states.

lcount=10;
print("Started™);

Active

tm(200)

print{count};
tmi300)

Pauzing
2
[elzel
[izDone )i

—count;
r
@

=™
l

print("Done");

e

tm(300) at ROOT. Pausing

tmiZ007 at ROOT Active

i=Cioner)

isDoned)

T

rint{h = 5

Pausing

00 at ROOT. Pausing

69

lcount=10;
print{"Started™);

Active

tm(200)/

T tm{300)

print{count);

Pau=sing

[elzel

[i=Donej)
print{"Done"};

—-count;
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Properties

» There are many properties that allow customization of
the tool and the generated code.

* Properties can be set once and for all by modifying
the site.prp file in the Rhapsody\7.5\Share\Properties
directory.

* The factory.prp and factoryC++.prp files contain all
the Rational Rhapsody properties.

A

It is recommended you modify the
site.prp or siteC++.prp files rather than
the factory.prp and factoryC++.prp files.
To do so, it is easiest to copy and paste
from these files into the site.prp or
siteC++.prp file.

a



Properties hierarchy

factoryC++.prp factory.prp
© @ site.prp

profile

configuration
A ifa stereotype Is @

applied to an

element, a property C class
Is assigned to that : .

Stereotype takes Operathn/attrlbUte/

precedence over the re|ation e/...

element’s property. /typ /

71

( SiteC++.prp
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Project properties

* Bring up the Features for the CountDown project and

select the Properties tab.

Entire Model View >

= 02 Compor T

- (I Object!  Add New »
=22 Package
= E] Def. Search...
5 @ Search inside...
= Locate on Diagram
| References...

Add to Favorites
Browse from here

Edit Unit...

Configuration Management 4
Format...

Rational Rhapsody Gateway
Rational Rhapsody Gateway Synchronize

9 Prec
-5 Preg

le-&

Project : CountDown

Gereral | Description | Felations | Tads |PTDDETtiES|

Yiew Commaon =

=!| Graphics
arid_display
grid_snap

OO0

MaintainindowZontent
=l CG
=l CEGeneral

GeneratedCodelnBrowser D
=!| ConfigurationManagement
=l General

CMTool

seSCChool Mo

= roD _CiC

Mone

General
The General subject contrals the general aspects af the Rhapsody display. 1t
containz the following metaclaszes:

* Model
* [araphics
* Prrfile

Locake Ok

(> ]]<

|
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Properties view

» There are a very large number of properties which can
be used to customize the tool and the generated code.

* |[n order to facilitate access to these properties, there
are several views that can be applied to the properties.

* For this training course, you use the most common
properties which can be seen using the Common view.

It is relatively easy to
modify the list of
properties that can be
seen in the Common
view.
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Properties views

» There are several useful views of the Properties:

Properties that have been
overridden for the currently
selected element & any
‘parent’ overrides

Al

Only properties that have
been overridden for the
currently selected element

View Common |~

COverridden

Locally Overridden

v Common

Filter...

.

A user defined list of the most
commonly accessed
properties

74

\, Properties filtered by

some keyword
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Useful property

* One useful property Is

General:Graphics:MaintainWindowContent.

» Setting this property means that if the size of the
window Is changed, then the view of the contents

changes proportionally.
= Set this property.

A

Once a property has been
modified it is highlighted. To
restore the default, right-click
on the property and select
Un-override.

Note also the description is
displayed for the selected

property.

Project : CountDown

General | Description | Relations | Tags | Properies

Wiew Common -

-| General A
=l Graphics
grid_display D
il 1
— 1= | = .
( MaintaintindosContent ’

= G

General: Graphicz:MaintainwindowContent P
The MaintairindowContent property specifies whether the wiewport [the part of a
diagram dizplayed in the window] iz kept for window resizing operations when you
change the zoom level, providing additional space in the diagram in a smooth

manner. The pozzsible values of the property are as follows:

* Checked - The elementz are rcaled according to the zoom factor o pou zee the
zame elements in the window, regardless of scaling.

* Cleared - As the diagram is scaled, some elements are hidden or revealed,
depending on the zoom. Thiz iz the behavior provided by previous vergions of
Rhapsody.

The following operations change the window size:

* Masimizerestone
* Tile

* Caszcade
* Manual resizing by dr.jrlgging llhe e_dg,a af the window ) “w
Locate 604
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Overridden properties

= Select View Overridden.

Project : CountDown

leneral | Descrphion | Relationsz | Tags
reG .
Wiew Oweridden -

=I| Graphics

Mainkain'WindowConkent

Froperties

Locake

A

This shows just the

properties that have been

modified.
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General:graphics:MaintainWindowContent

= Once this property has been set, changing the size of
a window should keep the same view:

55 Object Model Diagram:

@I Qverview

* You need to close any open windows and then

Display

= countint=0

%, Display()
& print(n:int)-void
[ print(s:char*):void
&isDone():bool
~Display()

(2

IS

EE
i -

reopen them after setting this property.

7
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Accessors and mutators

= [f accessors and mutators

General | Description | Relations | Tage | Properties

are not needed for S
attributes, then properties JEae :
can be set to stop their iy O
generation.

» Set these two properties 7, cocenes

GeneratedCodelnBrowsel D

so that ALL attributes In - Cotioratonanagement
the project will have

neither an accessor nor a - cpp_co
mutator. ,

[

CPP_CG:Attribute

The Atrbnte metaclazs cantaing nronerties that conteal attibobes of

Locate Ok
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Overridden properties

* For the attribute count, you want an accessor.
» Selecting the overridden filter shows that the

AccessorGenerate and MutatorGenerate properties
have been overridden higher up in the property

hierarchy.
» Select the count attribute and override the property:
AccessorGenerate.
General | Description | Felations | Tags | Properties
= ﬁ Default
--H Classes
- % Display
—- I Attributes
E COUNT R CPP_CG:Attribute:AccezsorGenerate ﬁ
¥ E Operations The .&u:-:essu:uan_anerate property specifiez I.-'-.I_hether to generate
acceszzor operations for attributes. The pozsible values are as folloves:
+- & Statechart
“I I;he:::ke::l - .-'1:-. g'it[] method iz generated for the attnbute. This iz the .
Lacake 0.4
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Locally overridden properties

» Select the View Locally Overridden filter to show
that just the AccessorGenerate property has been set

locally.
General | Description | Relations | Tags | Properties
Wiew Locally Overridden = }
=TTPP_CG
=l Akkribuk
Acressor zeneta £
Locak Ok

» Generate code and check that there Is just an

accessor for the attribute count.

80

int Display::getCount() const {
retorn count;
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Property filter

Filter Properties E|

= A customized view of the

properties can be created by Fle Tot | nmespac -
USIng the Fllter VleW for example: [ Match categary name CMatchprnpert_l,ldeg.:nptmb_

Filter Properties PS__<|

Filker Tesxt: |namespace w |

l Match category name y [ Match property description

[ Filter l [ Canicel ]

Project : CountDown

General | Descripticy | Relations | Taags |F'f'2'|:"ErtiES

[ Filter ]I [ Cancel ]

Project : CountDown

General | Description | Relations | Tags | Properties

T %
“iew Filkered By "nantezpace’’ ~

S——gprEg A
- Dieoandanc-
s ¥

(

.
Mamespacedlias \

UseMameSpace

=l Package

Defineflamespace
MameSpaceMarns
WSsDL [
=l Package
MNamespaces xsd=http: w3, orgf2001 RMLSchemasoap=http: ff:

TargetMamespace || httpef e, yourCompanyhane , comyyourProducthlame)

t Wiew Filtered By "namezpace” - "

=" General

=l Model
Reserveditords asm auto bad_cast bad_typeid break case cate—
= ATL

=l Canfiquration

TwpeliblmpartFarmat #import "$tlbPath” raw_interfaces_only, raw_r
= CPP_CG
=l aktribute

ImplementationEpilog

ImplementationProlog hd

ATL:Configuration: TypeLiblmportF ormat
The TepeLiblmportFormat specifies the template uzed to generate COM TLE import
statements,

Laocake Ok,

Default =

Himpart "$HEPath" raw_interfaces_anly, raw_native_typd
named_guidz

Locate QK
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Extended exercise

» Experiment with some of the properties such as:

CG:CGGeneral:GeneratedCodelnBrowser

* You must regenerate the code after setting this

property.

Project : CounktDown

Display

= count:int=0

A, Display()

& print(n:int):void

& print(s:char*):void
EisDone():bool
~Display()

B getCount():int

& startBehavior():bool

= EI Default General | Description | Relations | Tags | Properties
=-B Classes :
23 3 Wiew Common =
= % Display
= . ” -
= Attributes [€G
E count =l CaGeneral
=@ Operations GeneratedCodelnBrowss
~Display() onfigurationManagemen
¥ Display() - General s
ﬁ getCount() const CG:CaGeneral:GeneratedCodelnBrowser
E isDone() The GeneratedCodelnBrowszer property specifies whether canonical operations
A % [getizet] are added to the model and displayed in the brovezer. The poszible values
E print(char* s) are as follows:
& print(int n) _ _ -
ﬁ havi * Checked - Dizplay automatically generated operations in the broveser tree.
startBehavior ) * Cleared - Do not display canonical operations.
+ Statechart [Default = Cleared)
Lacate Ok,
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Formatting individual items

= L_ine Colors, Fill Colors, Fonts, etc of

selected element(s) can all be
formatted by right clicking and selecting

Format.

/count=10;
print("Started");

¥

Actiuve

Creste Sub-Statechart

Cut

[J— —

Copy

Displey Crptions ..
t {30 Deleta from Manl

Maks Defauft...

il
Lr

Pausing

Locate

Expand to fit text

O—Or—10

Add to Favorites
Browese from here

O 4 --count;
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Width:

Aetive

I tm(300)

yZ using

—— 0 Point {1 Pixel) =

Line | Fil
T Mina
T OCR A Extended B 'd ?‘D
H Palace Script MT B IcIIt lic 11
B Palatine Linatype
T Papyrus
H Pempetua
B Perpetua Tiling MT Sample
H PrimaSans BT
H PrimaSansMano BT AaBbCeDd
[™ Undedine [ Strike-Out Text Color: NN |~
0K | Cancel |
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Advanced drawing capabilities

» These advanced drawing capabilities are common to
most diagrams:

Show rulers

Snap to grid

Turn grid on/off

Align items to
common edge

R IBM Rational Rhapsody Developer for C++ - CountDown.rpy - [ObjectsModel Diagram: Overview *]
NG| File Edit View Code Layou§] Tools Window Help

Colaay s Wl

I\&FH & B &

?

Make item
same size

Give items same
spacing size

laaBoBEB v 8 |0 H#a%rE 2

B ¢ |Test

¥

V]Dg

SRR (RN Y =R

Entire Model View il v 7 ’

)

| = (3 SAlintDown
#4(_] Components
{1 Object Model Diagrams
=21 Packages
& Default
=B Classes
B aoc
= @ Display

e |

Stamp mode -
use when drawing
same items
repeatedly

#-E PredefinedTypes (REF)
@£ PredefinedTypesCpp (REF)
#-{(Z] Sequence Diagrams

EEX

DE®E BRC e« 5%

/7 B

'_='='.|‘ @ @ IJ % Avial

o

SRS S
—0 g g oge oo v
% .Disp|ay ,,,,, EE S EECIEEEY .\ 5] oA
5 o] I PN P S SC I DR P | Object
- | Hcourtint=g g o Class

- |- @print(niint)void- - - | - -
C T Rerint(sichaityvoid < 0T
5 S HisDone()boal © 54 i [SEAEEEEEA
. .| SgetCount(yint . T |

- - |- @startBehavior():boot - |- - - - - - -

N e e N

<

=: = e mer
. ——i-|x|
o x5 7Y =

Composite Class
Package
Port

Generalization
Assodiation
Directed Assodat
Aggregation

Composition
Link
Dependency

Flow
Realization
Interface

55| Overview *

%@w/wfﬁﬁcfwéﬂﬂmmvg

Actor

For Help, press F1

%

GE MODE' CAP | NUM SCRL| Mon, 11, May 2009 | 1:47 PM
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Aligning items to common edge

» A pivot selection mechanism is used for aligning,
sizing and spacing:

1. Select by area 2. Select the pivot class by holding Ctrl and selecting
Hroe MALlEss a8 M | g

VV'I e e el B el B e eRe] e inetn, S R eania iy [BEsimartd s ol lsare

—0 . | 3. Choosing
——5 | align left,
| aligns all
< | classesto
— 1 - | theclass
I i (class 4"

85 = = ==
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Site.prp / SiteC++.prp

* Adding new environments is done via the file
siteC++.prp.

» Each organization or team may want to always set
certain properties for all of their Rational Rhapsody
projects. To do this, set these properties for every
Rational Rhapsody project by putting them into the
file site.prp .

| These fIIeS 't"m akdit-32 - [D:\Rhapsody]3\Share\Propertiesisite CpP]
directory. |-

<

A B OUEiEEAddEeEt st umEBEWEBY @ 5 |i Fem-

G m S
Ln 15

Mod: 02/01§2008 15:20:40 File Size: 277
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Exercise 2A: Count down with Seven-Segment Display

" |t IS necessary to access the hardware. o P
= First prepare a hardware interface code. I/
* Then combine it with the model code.

* Model code + legacy code

a



Copy and modify fpga_test_fnd.c(1)

#include <stdio.h>
#include <stdlib.h>
#include <unistd.h>
#include <sys/types.h>
#include <sys/stat.h>
#include <fcntl.h>
#include <string.h>

#define MAX_DIGIT 4
#define FND_DEVICE "/dev/fpga_fnd"®

int dev;
unsigned char data[4];

88
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Copy and modify fpga_test_fnd.c(2)

int initSevenSegment(void)
{
dev = open(FND_DEVICE, O_RDWR);
if (dev<0) {
printf("Device open error : %s\n",FND_DEVICE);
exit(1);
}
}
void displaySevenSegment(int value)
{
data[2]=value/10;
data[3]=value%10;
write(dev,&data,4);
}
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Add Hardware Interface Code

* Right Click Test

Component and Select

Add New “File”

iR IEM R ational Rhapzody Developer for C++ - CountDown.rpy - [Statechart of
'E File Edit ‘“iew Code Lapout Tools *Window Help

M b BR SRR

...... CARD X (/]

AT 1 ITest

jIF{eIease

|l L i =

= =ReREN N

N -1 2 Display
Entire Model Yiew r + 4+ ‘
- D CountDown ;l
El {27 Components
S
B D Features... |
i ...' - =
Add Mew Component
E‘ D Object 1 I:D;fli:lguratiu:un |
__od Ove Cut Ee Liremerk
E| D Fackag Copy Crl+C e
Eﬁl Def | Faste (B8 Eclipee Configuration
EE Delete fram Model Del Wizual Studio Configuration
B Set Stereotype b Folder
Aetactor I
T
Mavigate 3 =
i Diagrams 3
Set az Active Component Frelafions >
[t b Annotations 2

LConfiguration M anagement

g |

Generate Component
Build Component

LI T Eralas
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* Double click a new file and change Name to
“SevenSegmentinterface” and Type to
Implementation

]D CountD o ;l
L——_Il:I Cormponents
= ,E Test
El D Configurations feount=10-
R % Release — — i
E D Files File : file_1 in Files *
=0 Ok tM.cI flllTj1 General |Descriptian| Elementsl Helatiansl Tagz I F'rn:-pertiesl
ject Model Diagrams
l:lDD Dwerview Mame: ISevenSegmentlnterface L |
= Fackages _
E'EI Dafaul Stereatype: I j %l%l
=B Classes Path: I » |
El% Dizplay Tomes -
E Attribute : IImpIementatu:un j
H é‘ SEPE”':I — Environment Settings
EI peratic
o i Disp E nwironment; ILinu:-:
:E Er[l’nfl Build Set: [Debug
""" = Compiler Switches: [ -|$DMDefauItSpecificatiDnDirectDr_l,l;I
EI . Statech A$0MROOT] ;I |
..... | Stat =
..... L = = ] E
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* Double click SevenSegmentinterface.cpp and select
the tab “Elements”.

= Then click New Text Element button

]E:l CountDlown
=3 Components

Elg Test
=-{_1 Configurations
. @4 Release
=1 Files

=7 Object Model Diagrams

=] Packages

=9 Default

=B Classes

El% Drigplay
- Attribute
-y Depenc
- Operatic
L Digy
= Tl
L prin
L prin
) Statech

------ @ Sevensegmentlnterface. cpp

| »

File : SevenSegmentinterface in Files

Active

Generall Description ~ Elements |Helatinns| Tagz I F'ru:upertiesl

@TEK‘}J-

@ SevenSegmentlnterface

92
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* Open the text editor

HEH:I Configurations
: "% MontaVista
-, Releaze

: H-[E] Huperlinks
=27 Files

@ SevenSegmentlnterface. cpp

ace in Files

Generall Description  Elements | Helatiu:unsl Tags I F'r-:upertiesl

@ SevenSegmentlnterface

File Text Elemeni

M arne:

Exl

T ezt Element:

Locate 0k, | 1] | |

K|

Dezcription;




= Paste the code and click OK

ElJD_"l CountDiown
=-{C3 Components

'

| {

MainTeszt.cpp | 4|

Locate ] | 1]

i Generating main file

58 Tost
=1 Configurations
| =%, MontaVizta #include <=tdio.h>
=R, Release #include <=stdlib.h>
- [E] Huperlinks #include <unistd.h:
=-{27 Files #include <=v=s/types.h:
- @ S evens egmentl nterface. cpp #include <svy=/stat.h>
: — #include <fontl.h:>
gmentlnterface in Files
Eenerall Description  Elements I Fielatil:unsl Tags I #include  <string. h>
#define MALX DIGIT 4
#define FND DEVICE "/dev/fpga fnd"
------ @ SevenSegmentlnterface int dev: B B
unsigned char datal4]:
int init3eveniegment (woid )
i
dev = open(FND DEVICE, O RDWR):
if (dev<0) {
printf("Device open error £zhvn", FND DEVICE] ;
exiti(l):

void displavievendegment (int value)

datal[z] =values/10;

Aatal3]l =sraln=%100"

Generating make file

Code Generation Done

Test.mak
ok I

Cancel Help |




=g CountDown

=-{23 Components
Elﬂ Test
=-_] Configurations
@4, MontaVista
El% Releaze

: [#-[E] Huperlinks
=-{23 Files

@ SevenSegmentlnterface.cpp
i renSegment nterface in Files

Generall Description  Elements | Helatiu:unsl Tags I Froperties

El@ SevenSegmentinterface

DX+ $

B #include <stdio ks
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New Configuration

» Right click Configurations and Add New

Configurations

* Change the name to MontaVista

* Right click and Set as Active Configurations

=g CountDawn
=] Components
EE Test
=1 Configurations
El% MontaVista
- #-[E] Hyperlinks
- =%, Release
[#-(E] Hyperlinks
=] Files
- @ SevenSegmentinterface.cpp
=1-_1] Object Model Diagrams
gl Overview
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Build

= Generate

= Generate

R IEM Rational Rhapsody Developer for C++ - CountDown.ipy - [SevenSegme

Configuration Main sEsmes|es o nnnx][as
" ! 9 ITest jIMDnta‘xfista
and Make files T TR IS o

L

Entire Model Yiew

41\

Sevense

Rhaps

Configuration
O g u a O EID CountDown Compo,
=27 Components FonFi
u n - : E Test a3
Model
o BUIId Conflguratlon EI{:I Configurations Fii Berer
: E| % am Features. . L
. Hyr o
» Check no error = Foas| A58Nen »
5 CRIET
=17 Files 8
=[5 Sevent Copy Chl+C
| 1 Bagte (Bl
Hlchecker Done + Madel Diagr.
- Delete from Model Drel
0 Error(s), 0 Warning(sz) WETVIEW
ages Set Stereotype 2
Code generated to directory: shome/control/work/Fhapzody/Counthowm/Test/MontaVista efault Change ta r
] Classes Refactar g
Code Generation Done ;
] ESF";T: Havigate 2
¥
0 Errori(s), 0 Warningis), 0 Message(s) . ! ) ) _
Building —----------- Test  ————————e e By Defl Sebasdictive Configuration
Compilineg Display.cpp EE Ope Edit b akefile :
Compiling SewendeguentInterface. cpp P iy E dit Configuration i ain File |
Linking Test =
- = Check
Euild Done =B Generate Configuratic kH:nn and Make Files
I {El Sta  Generate Configuratio
1N IE nnm Log ;’{. Check Model )H. Build h Configuration Managamant ,}H. Animation )H. Search Results {‘ 1 Packages Build Configuration i
v . el T 4 i, TOC LT T
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» Copy executable file to /nfsroot folder

control@lab-pc2:~/work/Rhapsody/CountDown/Test/Montavistas 1s

Default.cpp Display.h MainTest.h SevenSegmentInterface.o
Default.h Display.o MainTest.o Test
Default.o error.txt MontaVista.cg_info Test.mak

Display.cpp MainTest.cpp SevenSegmentInterface.cpp
control@lab-pc2:~/work/Rhapsody/CountDown/Test/Montavistas cp Test /nfsroot
control@lab-pc2:~/work/Rhapsody/CountDown/Test/Montavistas [

Computer

& Home
() DESktDD ;."3:5. ;."5:5 h ;."3:5.

Login Lagin Lagin

r r
Omo-a LOmoa

=
LOMmO=0

i} Documents ‘“ -
Default.cpp Default.h Default.o

i Downloads Display.cpl
& Music - - h

g 1n oq1n
l@ Pictures Compa Lomoa
@ Videos error.txt MainTest.cpp MainTeskt.h MainTest.c
= File System
& Trash h <> .

[PFPLo
Network SevenSegmentinter Test Test.mak

& Browse Net... face.o
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cd command with a long path name

= Move the mouse cursor to the menu bar

Ubuntu File Edit View GR Help

Computer

& Home

= Desktop Rhaps E,] “
&} Documents o Comng
Default.cpp Default.h Default.o

i Downloads
i Music Bhacs h

= Select Location from Go m

MontaVista

Computer ome/control/work/Rhapsody/CountDown/Test/MontaVista Q, search

& Home
K& Desktop Rhaps Rhaps h Rhaps
Login Login Login
ll‘wi: Documents Compa Compa Comoo
Default.cpp Default.h Default.o Display.cpp
£§ Downloads
i Music S h i
Login Login
@ Pictures | Compa Comp
. Display.h Display.o error.txt MainTest.c
@ videos piay pray. PP
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cd command with a long path name

* Copy and paste to the Terminal window

Computer

ome/control/work/Rhapsody/CountDown/Test/MontaVista €1 K
& Home

K& Desktop Rhaps Rhaps h fhags
Login Lagin =5
Comoo [ cogin

Lomoa Lomoa

I Documents

Default.cpp Default.h Default.o Display.cpp

i Downloads

@il Music Rhaps
- Login .
control@lab-pc2: ~fwork/Rhapsody/CountDown/Test/MontaVista

control@lab-pc2:~$ cd fhome/control/work/Rhapsody/CountDown/Test/Montavista
control@lab-pc2:~/work/Rhapsody/CountDown/Test/MontavVistas
control@lab-pc2:~/work/Rhapsody/CountDown/Test/MontaVistas
control@lab-pc2:~/work/Rhapsody/CountDown/Test/Montavistas
control@lab-pc2:~/work/Rhapsody/CountDown/Test/MontaVistas
control@lab-pc2:~/work/Rhapsody/CountDown/Test/Montavistas
control@lab-pc2:~/work/Rhapsody/CountDown/Test/MontavVistas

ce.cpp
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Run on the target

¥l COM3 - Tera Term VT
File Edit Setup Control Window Help

[root@ACHRO ~]# cd /mnt/nfs
[root@ACHRO nfs]# ./Test
|Consructed

Started
Count =
Count =
Count =
Count =
Count =
Count =
Count =
Count =
Count =
Count =
Count =
Done

[

e

@ =N WER VO 0W
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Run on the target with animation

» Change to Animation, build, and copy

Configuration : tontalfis

General Desu:riptiu:unl Initialization Settings | Ehecksl Helatiu:unsl Tags I F'ru:upertiesl

Directony: I.-"hu:ume.-"-:u:untr-:ul.-"wu:urk.-"ﬂ hapzody/CountD ovwndT est/bdontaista

Libraries: |

Additional Sources: |

Standard Headers: |

[nzlude Path: I

Ll L

[*| Use Default

— Instrumentation

|nztrumentation b ode: Arirmation

Advanced ...

—wehify

[ web Enabling

Srvanced ..

!

Time Model: s Real i Simulated

Statechart Implementation: ¢ Reysable i+ Flat

E nvironment 5 ettings

j Default |

E rwiranment; I b ot avizta
Build Set; IDehug j
Locate Ok | Apply | |

[»
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Run on the target with animation

iR IBEM Rational Rhapsody Developer for C++ - CountDown.rpy - [SevenSegmentinterface_ cpp]
File Edit “iew Code Lapout Toolz Window Help

DEeR|s2e v 222 |(A%KT X
I SRR AR )
| E DRI E T

|EaE = |

jIMDnta\fista j J | E

103

e e I == = = | Jlfﬂ:ﬁ\rial EE = S
I - 1| (= sevensegmentinterfa... X |
E ntire: Model Yiew r | 4 | Ehapsody PoT.bLT
Login P ocontrol
E|£:| CountDavin | Component : Test
EH:' Lompanents Configuration @ MontaVisiéa
EIE Test ) . Model Elepent ;o SevenSegme
=20 E;'”f'g“’at":'”? /71 Generated Date : Sat, 30, Di
=% MontaVista File Path : TestMontaVist.
Hyperlinks SEEEEFESEE SR A S I A A S F A LA S S
El‘k Releaze
- E-[E] Hyperinks #include <stdio.h>
=+ Files #include <stdlib.h>
e @ SevenSegrmentlnterface. cpp #include <unistd.h>
-] Object Model Diagrams #include <sys/types.hs
o E_EJ Overview #include <sys/stat.h>
= Packages #include <fontl.hs
=53 Default
EE ,E!E'SSES #include <string.h>




Open the driver

|-;|-{“_‘| Files
------ @ SevenSegmentinterface. of
El I:l Object Model Diagrams
E ------ 85| Dverview
=8 I:l FPackages
=g Ej D efault
Elg Clazzes
EPE% Dizplay
- Attributes
#-*s) Dependencies
El E O perations
5 i, |Display(]
B izDane(]
B printichar g
B printfint n]
I {E Statechart

Generall Description  Implementation I.-'-‘-.rguments Helatinnsl Tagz I Froperties

Hile rach s LEST MORTAVISTA AheVelRbegRenTInTa

Constructor : Display in Dizplay

|Display(]

cont <

"Consructed™ << endl;
init3evenlegment () ;
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Call Interface Routine

belzg] SevenSegmentinterface.cpp
El {:l Object Model Diagrams

” | f#include -<stdio.h>
P e _J Qwervigw
= {:I Fackages

Primitive Operation : print in Digplay *
=8 3 Default
=B Classes
EI%| Dizplay

Generall Description  Implementation |.-’-'-.rguments| Helatiu:unsl Tagz I Propertiesz

Ivn:niu:l priftfint r]
- Attributes

-y Dependencies cout << "Count = " << n << endl:
El E Operatiors: displagﬂevenﬁegﬂlﬁnt (1) :
o Digplal)

- g isDarel]

L printichar® 2]
------ E priftfint n)

- (&) Statechart
=7 Packages
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Load the driver and run on the target

¥ COMS3 - Tera Term VT
File Edit Setup Control Window Help

[root@ACHRO nfs]# ./Test
Consructed

Device open error : /dev/fpga_fnd
[root@ACHRO nfs]# ls

SocketCANexample* fpga_push_switch_driver.ko
StopwatchTest* fpga_test_fnd*
TestX fpga_test_push_switch*

fpga_fnd_driver.ko

[root@ACHRO nfs]# lsmod

[Module Size Used by

fpga push_switch_driver 1550 ©
[root@ACHRO nfs]# insmod fpga_ fnd _driver.ko
[root@ACHRO nfs]# mknod /dev/fpga_fnd c 261 @
[root@ACHRO nfs]# ./Test

[Consructed

Started

Count = 10

Count =
Count =
Count =
Count =
Count =
Count =
Count =

W s oy oW
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Exercise 3. Stopwatch Project

&



Create a new project

Mew Project

Froject name: IStnpwatchF‘rniect
[ folder: Ia’hnmea’cuntrula’wnrka’ﬁ hapsody./StopwatchProjec Browse... |
Project Type: I Drefault

Project Settings: I Drefault

=
L=

ok I Cancel Help

Rhapzody |

Directory Ahomedcontrolvwork /B hapsodysStopwatchProject does not exist
Do you want to create it?
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* Right click Packages and Add New Package
* Change the name to StopwatchPkg

iR IBM Rational Rhapsody Developer for C++ - StopwatchProjd

(L File Edit ‘iew Code Lapout Took ‘Window Help

;]D EEH B2 Y| E R 9 MR
{4 @) & @ 2 [DefauttComponent ~|[Deta
[ m i = = = e

-l -
41\

Entire Madel *iew ¥

E|"E:| StopwatchProject
l:| Components
l:| Ohject Model Diagrams
EH:| Packages
- F Default
£ PredefinedT ypes [REF)
£ PredefinedT ypesCpp [REF)
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» Right click StopwatchPkg and Add New-Diagrams-
Object Model Diagram

» Change the name to StopwatchOMD

iR IEM Rational Rhapsody Developer for C++ - [Object Model Diagram: StopwatchOMD in
Eﬁ File Edit “iew Code Lapout Toaol: Window  Help

berlétmre v @22 BHED| > | ||| EHmEHE
|4 @ ¥ ¢ [Defaurcomponent ~|[DetaultContig = m
[ oy i = = = | Er e

| FE StopwatchOMD in Stop... X |

Entire b odel Wiew ‘F‘ + + ‘

E‘"D StopwatchProject
- Components
- Object Model Diagrams
-] Packages
- 5 Default
ﬁ PredefinedT ypes [REF)
ﬁ PredefinedT ypesCpp [REF)
=-£5 StopwatchPhkg
-] Object Madel Diagrams
i E_EJ StopwatchObD
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» Select Object in Diagram Tools
* Draw three objects, Button, Timer, Display

é StopwatchOMD in Stop... Eﬁ Madell * ru ‘\Welcome ko Rhapsody I =

D]l

= Diagram Tools
Object

Class

Composite Class
Package
Port

1 Buttan 1 Timer 1 Dizplay

Gereralization

Associakion

Directed Associatiol
Aggregation
Compasikion

Lirk.

Dependency

Flow

Realization

Interface
Ackar

Common
Free Shapes

R =CLp T g T4 (PEITDC]
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» Select Link in Diagram Tools and draw links

5n StopwatchOMD in Stop... ]/; Modell * ru Welcome bo Rhapsody I ﬂ lxl
[ | L\‘g- Select
Qe Skarnp Made

= Diagram Tools
Object

Class

. 1 i ,
1 Buttan 1 Tirer Display Composite Class
Package

Prort

Genetalization

Associakion

Directed Association
Aggregation
Camposition

Link

Dependency
Flas

Realization

Interface
ackar

Free Shapes

SO P e 4 [(PEIIDC
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* Double click the link between Button and Timer
» Click Association change button

|E
=
Lin}

1 Button

Sterentype: I

Azzociation; IitsTimer-itsEuttnn
Endl: Timer
Marme: fitsTimer
Multplicity: || =

Wia Part: I

|— End2: Button

113
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» Change Both Ends to End itsTimer

M arne:
Stereat

Azeociz

—Endl
M arme

A Lltip
ia P

—End2

Mame

| [P T

1 Button

General | Endl I End2 I Endl propertiez | End2 prnpertiesl

1 Display

|»

M ame:

Stereotppe:

Conzists of;

Azzociation Ends

Fole Mame: |itsTimer

|'End 1: Button knowsz Timer as:

—End 2 Timer knows Button as:
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» Right click the link and change Display options

1

Button

itsTirner

Dizplay Ophions |
— Link Marne
i Mame " Label i Nu:-nes
—End1: Tirmer
F Name [ Multiplicity
— End2: Button
[ Mame [ Multipliciy
[ Sterectype [ Wisibility
ITI Cancel |

Display
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» Repeat the same for the link between Timer and

Display

1

Button

its Tirner

itsDisplay

1

Display
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» Select Button object and right click

= Add New-Statechart

O O ] .
1 Buttan 1 Tirner
itsTirmer
m m

Features. .

Add Hew Destuctor
Constructor...

£ Operation

Copy B G .-’-'-.tliril:uute

Copy with todel :
Structure Diagram

Delete from kModel Fort

Rermaove fram YWigw Del
FlanaPart

Set Stereotype g

Change to = .
Aotk

Fefactor b g

M avigate

| S T I P )
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= Select State and draw states.

= Diagram Tools

held

idle

118

[=

*tTRE-0@0H //

State

Transitian

Default Transition
and Line

Condition Connecke
Histary Conneckor
Termination Conner
Junction Canneckar
Diagrarm Conneckor
EnterExit Point

Jain Sync Bar




= Select Transition and draw
= Double click the transition

= Type in Trigger

= Type in Action: Timer.GEN(evStartStop);

I

- evPress

held

: evPress/
idle | Timer. GEN{evStartStop);

.

pressed

Transzition : 1 in StatechartOfB utton *

General | Descriptinnl Tags I F'ru:upertiesl

»

M ame : IevF‘ress.-" Timer. GEM[ewStartStop);

Stereotype: I

T arget Ip eeeee d

Trigger : IevF‘ress

Guard ; I

Actian

Timer.GEN (ev3tartitop) ;
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» Complete the statechart

held
idle ovPress/ pressed
Timer.GEN{evStartStop);
]
evRelease
tm(3000)/ tm(30)

Timer.GEN(evReset);
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= DO
= Se
= Se

nle click Display object and open Feature window
ect Operations Tab and press New
ect Primitive Operations and name print

1 |

Tirner ! Display
itsDisplay
1 [m]
& print(:void

[} ] 0
3enera II Descriptianl Attributes  Operationz |F'n:|rts I Flaw Parts Helatiansl Tagz I F'rn:npertiesl
[ Shaow Inherited i bt

M ame | YYigibility | R eturn Type |
= e Public woid
Mews

Locate | ]8 | Sppll I |
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» Double click print operation
» Select Arguments Tab and add arguments: min, sec.

Frimitive Operation : print in Dizplag *

Generall Descriptinnl Implementation  Arguments I Helatinnsl T agz I F'rclpertiesl

Iw:uil:l prifkfink mirint zec)

SE K

M anne | Type | W alue | direction |
E['] it ik Ir
E['] FEC i Ir

<Mew:

» Select Implementation and type in code

Frimitive Operation : print in Dizplay

Generall Description  Implementation |.&rgument3| Helatinnsl Tags I F"rclpertiesl

I\-'l:uiu:l printfink mir,int zec]

printf("sd:xdvn"™,min, sec) ; -
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* Double click Timer object
» Select Attributes Tab
» Add attributes(seconds, minutes)

[} 1 |

1 Tirmer 1 Display
M seconds:int
M minutes:int
itsTimer itsDisplay
0
& print{mincint se.
O I} 0
Object : Timer in StopaatchPkg
Generall Description  Attributes I I:Iperatiu:unsl Forts I Floy F'-:urtsl Helatinnsl Tags I F'ru:upertiesl
[T Show Inherited i =
Mame | wisibility | Type | Initial Y alue | Walue |
B second: Public int 1]
M minutes Public int 0
Mew:
Locate ] | oy 1] | |

123




» Add operations(print, tick, reset) in Timer object

0 ol iy 1 Displa
1 Tirmer Lhzplay

M seconds:int
M rinutes:int

itsTirmer it=Display
0

& print():void & print{mincint se.
& tick(:void
& reset(void

[} 0 |

Object : Timer in StopwatchPka

Generall Description | Attibutes  Operations I Puortz I Flaws Portz Helatinnsl Taogz I F'ru:upertiesl

[ Show Inherited 4y »
M ame | YYizibility | Feturn Type |
& print Public void
B tick Public void
B reet Public vaid
<Mews

Locate | OF. | Apply | |
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* Double click print operation
* Add Implementations

o o o ;
- 1
1 Timer Display

M seconds:int

M rminutes:int

itsTirmer it=Display
1

& print):void & print{mircint se..
& tick():void
& reset{ivaid

0 = m|

Primitive Operation : print in Timer *

Eenerall Description  Implementation |.-’-'-.rguments| Helatiunsl Tagz I Properties

Iv-:uid prinit(]

Dizplavy.print (minutes, seconds) ,:I

w
a| | b

Locate | OF. | Apply | |
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* Double click tick operation
* Add Implementations

T R il 1 Display
1 Timer

M seconds:int
M rminutes:int

itsTirmer it=Display
0

& print):void & print(mincint g2
& tick():void
& reset(vaoid

0 | |

Frimitive Operation : tick in Timer *
Generall Description  Implementation I.ﬂ.rguments Helatiu:unsl Tags I F'r-:upertiesl
[void tick()
seconds++; -
if [ seconds > 59 ) {
seconds=0;
minutes++;
¥
-
4| | b
Locate | Ok, I Apply ||

126




Timer attributes

* Double click reset operation
* Add Implementations

o o o :
- 1
1 Tirmear Display

= seconds:int
M rminutes:int

itsTirner itsDisplay
0

& print():vaid & printimin:int se...
& tick():vaid
& reset()void

(N, () |

Primitive Operation ; reset in Timer *

Generall Description  Implementation |.ﬁ.rguments Helatiu:unsl Tags I Froperties

Iw:uiu:l rezek]

seconds=0; Y
minutes=D;|

-
4| | r

Locate | ] | Apply I |
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Statechart in Timer

* Right click Timer and Add New-Statechart

evReset/
reset();print();

running
freset();
print();
off evStartStop on
evStartStop
tm{(1000)/
tick(); print();
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Object Model Diagram

= Stopwatch OMD

1 Button

=

itsTimer

1

Timer

(=

= seconds:int
= minutes:int

B evPress()
B evRelease()

& print):void
& tick():void

& reset():void
B evStartStop()
B evReset()

itsDisplay

Display

129

& print(min:int,sec:int):void
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Generate and build

» Change component and
configuration names

= Generate and build

= Compiling Button.cpp
Compiling Timer.cpp
Compiling Display.cpp
Compiling StopwatchPkdg. cpp
Linking StopwatchTest

Euild Done

L I 4 I }I HI'-. Log .f{. Check Model }H. Euild }H. Configuration Managernent }HL

For Help, press F1

Entire Maodel Wigw T

&r\

E|--{.:_—| StopwatchProject
-1 Components
EE StopwatchT est
EI{:l Configurations
El‘k Linux
E| Hyperinkz

[F] Edit Main File
[F] Edit Makefile
+-{_1 Object Model Diagrams
=1 Packages
- 3 Default
B PredefinedT ypes [REF)
B PredefinedTvpesCpp [REF]
E‘B StopwatchPkg
- % Events
F-Ly Links
=] Object Model Diagrams
g StopwatchOMD
=-7] Objects
=5, Button
- Azzociation Ends
= Operations
- evPress)
- -l evRelease()
(B Statechart
----- & StatechartDiagram
A default of idle
=) States
500 el

| »

130
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Configuration : Linus in StopwatchT est

Generall Descriptinnl Initialization ~ Settings I Ehecksl Fielatil:unsl Tags I Froperties

Directony: IJthe.-"n:Dhtn::I.-"wnrk.-"H hapzody/StopwatchProject/StopwatchT est/Linus
Libraries: I

Additional Sources: I

Standard Headers: I
|hzlude Path: I

N ERERA

— Instrumentation

¥ Use Default

|nztrumentation bode; Aimation Advarced |
—febify
[ web Enabling Advaneed) |

Time bodel: * | FBeal i Simulated
Statechart Implementation: ¢ Reysable s Flat

Ervviranment Settings

j Drefault |

Ervviranimett; I Liruz
Build Set: I Debug j
Locate k. | Apply | |

[»
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R IEM R ational Rhapsody Developer for C++ - StopwatchProject.

& File Edt “iew Code Layowt Tools “indow Help

DRy @e v =29 @k %
IR AR AR |
JJ@ m 0 ol e IStDpwatchTest

Il I:I:

jILinux
_ s U = =) = R e
. pilry

=B StopwatchPlkg

\ Ewvents
#-L Links

-1 Object Model Diagrams

Elﬁ Ohjects

EIEI Butto
=&
=

H-(B) 5

=8 0

Eﬂ"ﬁ: Timner

i

Ly Azzociation Fode
Instances

O perations

tatechart

Elﬁ Diigplay
- Instances

perationg

------ B prirtfiet r

Eeatures...
Add Mew

Search...

Search inzide...

Laocate on Diaagramm
References...

Show Relationz in Mew Diagram
Add to Favoritez

Browse from here

133

ii ;I Create Lnit f
Change ta
[ Ejeet Blttam{l]
= Open Instance Stegechart
1 | I _'I—I Generate Event L
Call Stack / Add Breakpaint



» Right click and Generate Event

I held
evFress!
, i
idle Timer. GEN(evStart Stop); preese
-
evRelease T
trm {3000 tm{30)
Timer. GEM{evReaszet);
Features...
Fiazte (S
Refactor »
M awvigate 4
Add Breakpoint

Switch bo Tabular View E |
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= Generate evPress and evRelease within 3 seconds

135

Object: IButtu:un Select |
Event: I evPress j
Arguments;
M ame | Tupe I Walue | Edit |
Higtary:
Buttan-> GEMN[evPress(]) Clear
Buttan-> GEM[evRelease(]] _I
Cloze Help

.|||
oy



Panel Diagram

* One way of testing the model Is to use a panel.
* Add a Panel Diagram called Dishwasher Panel.

E ntire Model iew L +

E--g StopwatchProject
l:l Cormponents
I || R Tmer* | B Timer - Timer - Object Model Diagrams
+ ¥ ‘ EH:l Fackages
----- ﬁ Default

| B PredefinedTypes [REF)

Entire Maodel \fiew T

] StopwatchProject

Eli:l Components eatures... ﬁ PredefinedT ypesCpp [REF]
SRARTTEY  Add New Package . @ StopwatchPkg
EEEQH:T Search. Companent E|l:| _F'jnl Diagrams
BB Search inside... Settings o - topwatchPanel
Locate on Diagram Profile - evPress/
! Beferences. . e EE
) . Diagramz Clazz Diagram i
- Object Mods!  Addta Favorites Relations  »  Object Model Diagram
=" B fram h
= q--gcgzgfl:jlt roiEs TTam et Annaotation:  # Seguence Diagram —
EI Predefiis E dit Lt —  Uze Caze Diagram &l ﬁ
: . C kO
E Predefine Configuration M anagement DZﬁEE:_ZT_It Dliagg':far:-l Panel Dl ag rams can
E-E Stopwatc Fomnat B
.- Collabaration Diagram .
\ E.veru Structure Dia rarﬁ e Only be used Wlth
---|—| Links g . ]
I:l Object Model Diagrams %I an|mat|0n
=] Objscts . .
2 £ outon configurations.
i ML Agsociation Ends
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Panel Diagram

* Add LEDs, push buttons, level indicators, and a digital
display to the panel.

- ) Enob
digitaldisplay 0O digitaldisplay_1 )y Gauge
a3 Meter
= Level Indicator
=i Makrix Display
pushbutton_D pushbutton 1 2 Digital Display
() Led
evPrass evFelease 7 On OFF Switch
[#]  Push Buttan
| [ EButkon Array
| DigitalDisplay : digitaldisplay_0 (=
— & Slider
Elemnent Binding | Settingsl Froperties Element Binding I Settingsl
Instance Path: Instance Path:
IStnpwatchF‘kg.Timer.minutes IStupwatchF’kg.Buttu:un.evF'ress
[ Display &l Types [ Display &l Types
ElI:| StopwatchProject =27 StopwatchProject
ElE| StopwatchPkg ElEI StopuatchPkg

E‘@ Timer E@, Buttan
He el
o = riinutes P & evReleaze
-2 Timer
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* Run on the target with or without animation

DULLLN T = DLy -

E ntire M odel igw ¥

41\

|

JLUpP L IE e

I =

=41 StopwatchProject
=1-{_] Components
E‘E StopwatchT est
=1-{1 Configurations
El‘k Liri
LB - Hyperlinkz
----- EE‘I E dit M air File
----- o [F] Edit Makefile
El ‘k MontaYista
[#-[E] Hyperlinks
F-{27 Object Model Diagrams
—-{_7 Packages
- Default
-4 PredefinedTypes (REF]
£ PredefinedTypesCpp [REF)
=B StopwatchPhkg
\ Ewvents
Ly Links
l F-{21 Object Model Diagrams

ml.-.I51

¥l Azzociation Ends
#- @ Operations
--{El Statechart
Elﬁ Display
= E Operations

------ B prirtfint minint sec)
I'_—'I--E Tirner
-l Agzzociation Ends
- Attributes

4I|

Configuration : Montay

zta in StopwatchT est

Generall Desu:riptiu:unl Initialization  Settings |Ehecks| Helatiu:unsl T

Directony:

I fhomedcontroldwork /RhapsodyS topratchProje

Libraries: |

Additional Sources:; |

Standard Headers: |

Include Path: I

— Instrumentation

Inztrumenitation kaode: I.-’-'-.nimatin:-n

— Wiehify
[ web Enabling

Tirne Model: i+ Feal

Statechart Implementation: ¢ Reyzable

i Simulated
i+ Flat

E nvironment Settings

Enwiranment; I M ontavista
Build 5et: |De|:.ug
Locate 0k | Sppl I |
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Exercise 4. Button Project

» Run the ButtonProject on the target with o N
or without animation. i |,

Computer
& Home

& Desktop i i L
I Documents iActs

d

: ButtonProject_ ButtonProject_rpy ButtonTest ButtonProject.ehl
ikd Downloads auto_rpy
i Music ] .
[@ Pictures Lo L
51z - my
i@ videos ButtonProject.rpw  ButtonProject.rpy  ButtonProject.save core
= File System ——
& Trash 12, 3
12, 3
Network error.log

izl Browse Net...
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Object Model Diagram

* Object Model Diagram in ButtonProject

! Buttan = 1 Led =
itsLed

B evPress() B evPress()

B evRelease() B evChange()

itsButton

1 PushSwitch &

140
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= Statechart in Button

held

: evPresss
il | Led. GEN{evChange);

evFelease

State : preszed in StatechartOfButtan

General | Descriptinnl Helatiunsl Taogz I Froperties

M ame:

Stereotype: I

Action o entry

if (lreadPushiwitchi)] Button.GEN|(evRelease);
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= Statechart In Led

finitLed(;
T One (éjﬂ Two e Three
evlChange evlzhange
o m]
0 i, |
T evlChanoge

State : One in StatechartdfLed

General |Desu:riptiu:un| Helatinnsl Tags I Properties

M arne; IE

Stereotppe:; I

Action on entry

B
=] B |

onledil) ;
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" Interface.cpp

Entire Model Yiew L

-L:r|

B Pushswitch | Eﬁ Button Crverview in BukkonPl

El--m ButtonProject

-] Components

EE ButtonT est
E||:| Configurations

: % Monta¥ista
=] Files

------ @ Interface. cpp
-27] Object Model Diagrams

=] Packages
Eﬁ ButtonPkg
\ Events
&L Links
EH:l Object Model Diagrams
£ ﬁ_ﬁj Button Overview
Eﬁ Objects

ElﬁI Buttan
E F-L Association Ends
E Operations

+-{&) Statechart
= R

finitLed();

File : Interface in Files

Generall Description  Elements | Helatiu:unsl Tags I Froperties

El@ Interface
S tinclude <stdio b
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Interface.cpp(1)

Interface.cpp %

#include <stdio.h>
#include <stdlib.h=
#include <unistd.hs>
#include <sys/types.h=
#include <sys/stat.h=
#include <fentl.h>
#include <sys/ioctl.h=
#include <signal.h>

#tdefine MAX_BUTTON 9

int dev_switch, dev_led;

int buff_size;

unsigned char push_sw_buff[MAX_BUTTON];

int initButton(void)|

{
dev_switch = open("/dev/fpga_push_switch", O_RDWR);
if (dev_switch<0){
printf("Device Open Error\n");
close(dev_switch);
return -1;
1
1
int initLed(void)
{

dev_led = open("/dev/fpga_led”, O_RDWR);
if (dev_switch=0){
printf("Device Open Error\n");
close(dev_led);
return -1;

}
buff size=sizeof(push_sw_buff);




Interface.cpp(2)

unsigned char readPushSwitch(void)

145

| push_sw_buff[8];

H read(dev_switch, &push_sw_buff, buff_size);
return push_sw_buff[6]| push_sw_buff[7]
}
void onLed(int number)
{
unsigned char data=0;
if(number==1) data=1;
if(number==2) data=2;
if(number==3) data=4;
write(dev_led,&data,1);
}

f'*********************************************************************

File Path : ButtonTest/MontavVista/Interface.cpp

ttttt*ttttttt*ttttttt*ttttttt*ttttttt*ttttttt*ttttttt*ttttttt*ttttttt!




= Statechart in PushSwitch

AinitButton();

1 1
ReadSwitch (%)

1 |
T tm(30)

Stereotype:; I

Action oh entry

if (readPushfwitchi()) Button.GEN|ewPress);
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Exercise 5. Stopwatch with real displays and switches

= Modify the StopwatchProject to use o P
seven segment displays and push |
switches on the target

» Use two digits for minutes, and two digits
for seconds

» Use three bottom row push switches.

a



